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About this guide 

Purpose and scope 

This guide is designed to help you to get started using FoodWorks® 10 to produce 
nutrition labels. You can use either FoodWorks® Nutrition Labelling Edition or 
FoodWorks® Premium Edition for nutrition labelling—and this guide applies to both. 

 

 

This guide assumes that you are a new user of FoodWorks, and that you are creating a 
new FoodWorks database. 

To produce nutrition labels you need a good working knowledge of the Australia New 
Zealand Food Standards Code and other relevant legislation. This guide does not attempt 
to teach or reproduce these regulations.  

Note that using FoodWorks in no way ensures that you are complying with the relevant 
legislation and regulations. You need to seek independent expert legal advice to ensure 
this. 

This guide also assumes that you have a broad knowledge of the advantages and 
limitations of computerised nutrition analysis. 

Please note that this guide does not cover how to do Country of Origin Labelling or 
Health Star Ratings in FoodWorks—please see the Related Documents below. 

Related documents 

The following guides and articles are available from the FoodWorks support site: 
support.xyris.com.au.  

Country of Origin Labelling (CoOL)  

For how to do Country of Origin Labelling in FoodWorks, see this complementary guide, 
available from the FoodWorks support site: 

Getting Started with Country of Origin Labelling in FoodWorks 10  

Health Star  Ratings  

For how to generate Health Star Ratings for your products using FoodWorks, see this 
complementary guide available from the FoodWorks support site: 

Getting Started with Health Star Ratings in FoodWorks 10  

http://foodworks.zendesk.com/
https://support.xyris.com.au/hc/en-us/sections/201019539-Getting-Started-Guides
https://support.xyris.com.au/hc/en-us/sections/201019539-Getting-Started-Guides
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Working with BarTender for CoOL and HSR 

To work with the BarTender® Label Software using data from FoodWorks to produce 
labels that include Country of Origin Labelling or Health Star Ratings, see this support 
article: 

Tutorial: FoodWorks and BarTender  

Dietary analysis  

If you are using FoodWorks Premium, and you are also using it for dietary analysis 
and meal planning, the following guide is helpful: 

Introduction to Dietary Analysis with FoodWorks® 10  

Conventions 

Each step-by-step computer procedure is introduced by a mouse icon          in the left 
margin. 

Example 

To create a new database: 

1. On the FoodWorks toolbar, click New, then click FoodWorks Database File.  

Getting more help 

On FoodWorks 

We recommend that you use this booklet as a guide for your nutrition labelling work 
with FoodWorks. There are also several other ways to get help using FoodWorks, 
including: 

▪ On-line help 

To get help on using FoodWorks: On the FoodWorks Help menu, click Help Topics.  

• FoodWorks support site 

To search our knowledge base and to submit support requests, please go to the 
FoodWorks support site: support.xyris.com.au 

On the Australia New Zealand Food Standards Code 

You can access the Food Standards Code, and assistance with implementing it, at 
www.foodstandards.gov.au. 

https://support.xyris.com.au/hc/en-us/articles/360000100616-Tutorial-FoodWorks-and-BarTender-
https://support.xyris.com.au/hc/en-us/articles/204538859-Introductory-Guide-FoodWorks-Professional
http://foodworks.zendesk.com/
http://www.foodstandards.gov.au/
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Contact details 

Telephone 
+61 7 3223 5300 or 1800 875 549 
 
Email: info@xyris.com.au 

Web:  
xyris.com.au 
support.xyris.com.au 

mailto:info@xyris.com.au
http://www.xyris.com.au/
http://foodworks.zendesk.com/
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1. About FoodWorks  

FoodWorks® Nutrition Labelling Edition and FoodWorks® Premium Edition are 
designed to assist companies developing food products and producing nutrition 
labelling information under the Australia New Zealand Food Standards Code and other 
legislation.  

FoodWorks automatically generates nutrition information panels (NIPs), ingredient 
statements, allergen declarations, Country of Origin standard marks and statements, 
and Health Star Ratings, to comply with the regulations. And FoodWorks offers 
advanced options to give you flexibility in designing and publishing your nutrition 
labels. 

You can also use FoodWorks to assist with new product development. With FoodWorks, 
you can perform “what if” style calculations to evaluate the nutrient composition of 
possible new products and easily compare variations of a product. 

FoodWorks lets you manage your recipe and ingredient data effectively. For example, 
when you make changes to an ingredient in FoodWorks, the changes automatically flow 
through to recipes and their nutrition labels are updated.  

Food Standards Code and other legislation 

FoodWorks supports the Australia New Zealand Food Standards Code in relation to 
nutrition labelling and ingredient statements, in particular the following sections:  

▪ 1.2.3 Mandatory Warning and Advisory Statements and Declarations 

▪ 1.2.4 Labelling of Ingredients 

▪ 1.2.5 Date Marking of Packaged Food 

▪ 1.2.6 Directions for Use and Storage 

▪ 1.2.8 Nutrition Information Requirements 

▪ 1.2.10 Characterising Ingredients and Components of Food 

FoodWorks supports the Country of Origin Food Labelling Information Standard 2016 
(under s.134 of the Australian Consumer Law - Schedule 2 of the Competition and 
Consumer Act 2010). Note that this functionality is covered in the companion guide: 
Getting Started with Country of Origin Labelling in FoodWorks 10. 

FoodWorks supports Health Star Ratings according to the guidelines the following 
guidelines: Guide for Industry to the Health Star Rating Calculator (February 2018) – 
how HSRs are calculated; Health Star Rating system Style Guide (December 2017) – 
guidance for the application of the Health Star Rating system on food packages; the 
Australia New Zealand Food Standards Code. Note that this functionality is covered in 
the companion guide: Getting Started with Health Star Ratings in FoodWorks 10.  

 

FoodWorks 

makes it 

easier to 

comply with 

the Food 

Standards 

Code. 

http://www.foodstandards.gov.au/code/Pages/default.aspx
https://www.legislation.gov.au/Details/F2017C00920
https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-in-FoodWorks-9-Nutrition-Labelling
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/content/guide-for-industry-document
http://healthstarrating.gov.au/internet/healthstarrating/publishing.nsf/Content/style-guide
http://www.foodstandards.gov.au/code/Pages/default.aspx
https://support.xyris.com.au/hc/en-us/articles/360001045316-Getting-Started-with-Health-Star-Ratings-Guide
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Features 

Food composition data  

FoodWorks provides reference foods and nutrient data from Food Standards Australia 
New Zealand (FSANZ), as well as other data sources. The nutrient analysis for simple 
raw materials can be based on data from these reference data sources. 

Label design  

FoodWorks automatically generates draft labels from your recipes with the click of a 
button. You can then refine the label to suit your particular requirements. You can 
choose from a variety of content and layout options.  

For Nutrition Information Panels, FoodWorks will: 

▪ Automatically generate a nutrition information panel from the recipe using default 
settings 

▪ Automatically round nutrient values 

▪ Automatically update the label if an ingredient in the recipe changes 

You can choose to: 

▪ Show just the mandatory nutrients, or add others 

▪ Show values per serve and per 100g, or per 100mL for beverages 

▪ Show the % daily intake column with the prescribed explanatory message 

▪ Show ‘less than’ for small nutrient values where applicable 

▪ Show Calories as well as kJ for energy 

▪ Include servings per pack and serving weight 

▪ Override the generated nutrient information 

▪ Set the font, capitalisation and use of gridlines 

For Ingredient Statements, FoodWorks will: 

▪ Order ingredients by ingoing weight with automatic adjustment for water loss or 
gain 

▪ Automatically combine ingredients with the same declaration name  

▪ Automatically merge the ingredients of sub-recipes to create a single list 

You can choose to: 

▪ Show characterising ingredients or components (such as milk solids) 

▪ Calculate the percentage of a characterising ingredient or component 

FoodWorks 

offers 

advanced 

options for 

designing and 

publishing 

your labels. 
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▪ Add your own declaration name for an ingredient 

▪ Declare an ingredient as a simple ingredient, compound ingredient, processing aid, 
additive, inedible component or reconstituted ingredient 

▪ Declare an ingredient as part of a group, for example, nuts (brazil, cashew), where 
nuts is a group you have defined, and brazil and cashew are ingredients 

▪ Use different statements for an ingredient depending on whether it is more or less 
than 5% of the total recipe 

▪ Set the font and capitalisation 

For allergen declarations, FoodWorks will: 

▪ Set allergens at the ingredient and recipe level 

▪ Generate Contains and May contain statements 

FoodWorks also handles other label elements, allowing you to:  

▪ Use an alternative name for the label (other than the name for the recipe in your 
database) 

▪ Include a description for the label 

▪ Include a description for the serving size 

▪ Include preparation instructions and storage instructions 

▪ Include Country of Origin statements (more detail below) 

▪ Include Date Marking statements 

▪ Include Net Weight 

For Country of Origin Labelling, FoodWorks: 

▪ Calculates the percentage of Australian ingredients for your recipes 

▪ Helps formulate your text statements 

▪ Allows you to include the appropriate graphical standard mark (bar chart and logo) 

▪ Provides the CoOL Editor to make it easier to enter the percent Australian for all 
your raw materials at once 

▪ Provides the CoOL Explorer so you can examine how the CoOL values in the raw 
materials and sub-recipes contribute to the CoOL value for your final recipes 

For Health Star Ratings, FoodWorks: 

▪ Once you set the HSR category for your recipe and enter the FVNL and cFV values 
for your raw materials, FoodWorks can calculate the HSR.  

▪ Provides the FVNL Editor to make it easier to enter the FVNL and cFV for all your 
raw materials at once. 
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▪ Allows you to examine the Baseline Points, Modifying Points and Final Points for the 
recipe/product in the HSR Explorer. 

▪ On the label for the recipe, you can choose from a range of compliant HSR system 
graphics.  

Publishing labell ing information 

FoodWorks includes a variety of options for publishing your nutrition label information. 
You can: 

▪ Print labels directly from FoodWorks for any label printer supplied with a Windows 
printer driver  

▪ Integrate with your label printing software 

▪ Produce a label, then with a single click open it in Microsoft Word  

▪ Use the Publish with Microsoft Word feature for complete formatting control of 
the label 

We also make available the graphical assets needed so that you can integrate labels 
including HSR graphics with BarTender or other label-printing software.  

Ingredient costing  

You can import ingredient costs from Microsoft Excel. Watch ingredient cost change in 
the Analysis Pane as you modify your recipe. 

System requirements  

▪ Windows 7, 8, 8.1 or 10; Windows Server 2008 or later 

▪ For publishing to Microsoft Word, Microsoft Office 2013 or later is required 
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2. Getting started 

This chapter explains how to start and exit FoodWorks, and how to create your first 
FoodWorks database. We also introduce the major elements of the FoodWorks 
application window, and finish with a practical exercise to help you get familiar with 
FoodWorks. 

Downloading and installing FoodWorks 

To download and install FoodWorks 10, go to xyris.com.au and follow the instructions 
shown.  

NOTE: There is a single download for all the editions of FoodWorks 10. For the free 
trial period, you have access to the functionality of FoodWorks Premium, which 
combines the functionality of both FoodWorks Nutrition Labelling and FoodWorks 
Professional.  

When you purchase FoodWorks you are issued with a product key. Your product 
key enables the features of the FoodWorks edition that you have purchased.  

The free trial begins when you start FoodWorks for the first time. To continue 
using FoodWorks after the free trial expires, you need to purchase it. 

Starting FoodWorks and creating your first database 

To start FoodWorks and create a FoodWorks database for nutrition labelling and new 
product development: 

1. Click the Windows Start button.  

  

2. Locate then click FoodWorks 10.  

 

http://www.xyris.com.au/
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3. If this is the first time you have started FoodWorks, or you are trialling FoodWorks, 
the following dialog is displayed.  

 

In the above dialog, you can click to start the free trial, enter your product key if you 
have already purchased FoodWorks, or purchase. 

4. If this is the first time you have started FoodWorks, read the FoodWorks License 
Agreement.  To accept and continue, click I accept.  

5. To create a new database, click Create. 

Example 
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A list of different types of databases is displayed on the left.  

 

6. To see information about each type of database in the list, under the country you 
require, click its name. A description appears on the right.  

 

7. Select a type of database appropriate for both: 

• your country (in this guide we use Australia) 

• what you want to do (Nutrition Labelling and New Product Development) 

Then click OK. 

8. Type a name for the new database and browse to an appropriate location to save it.  

 

NOTE: It is important to choose a location where you know that your FoodWorks 
database file will be regularly backed up. See Backing up your database on page 12.  

9. Click Save. 
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FoodWorks is started with your new database open. 

NOTE: The 14-day free trial   

The free trial begins when you start FoodWorks for the first time. To continue 
using FoodWorks after the free trial expires, you will need to purchase FoodWorks 
by going to our website or contacting us. For contact details see page 2. 
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About your FoodWorks database 

Your FoodWorks database is a repository for the work you do in FoodWorks. You store 
all the ingredients and recipes that you create in this database.  

For nutrition labelling tasks, you need a nutrition labelling database appropriate to your 
region. You selected this when you created your first database by stepping through the 
process in Starting FoodWorks and creating your first database on page 8. 

 If you still need to create a database, see Create a new database on page 21. 

Backing up your database 

It is very important to ensure that your FoodWorks database is backed up regularly. 

If you are working in a networked environment, there are usually shared network 
drives available that are automatically backed up by your system administrator. In 
general, your FoodWorks database should be stored on one of these network drives. 
You should check the location of your database, and move it if necessary. 

FoodWorks provides a simple option for backing up the currently open FoodWorks 
database.  

To back up your database using FoodWorks: 

1. On the FoodWorks Tools menu, click Back up Database. 

2. Select the location and name for the backup. 

3. Click Save. 

Finding your database  

When you start FoodWorks you are asked whether you want to create or open a 
database. The databases you have opened recently are listed on the right, along with 
their file location. 

If you select the checkbox Do not show this dialog again, then in the future, the last 
database you worked with is opened. 

To view the location of the currently open database: On the FoodWorks File menu, click 
Database Properties. The location of the database is displayed on the General tab. 

Moving your database 

A FoodWorks database is stored as a single file with the extension .fwb. 

To move your database: First, find its current location (see above). Then use Windows 
Explorer to move it to the correct location. Note that you need to close FoodWorks 
before moving the database. 
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FoodWorks documents and templates 

Each ingredient and recipe that you create using FoodWorks is referred to as a 
FoodWorks document. There are different types of documents. You can organise your 
documents into folders within your FoodWorks database. 

The default document types available in a nutrition labelling database created with 
FoodWorks 10 are: 

Icon in 

FoodWorks 

Document Usage 

 
(bowl) 

Recipe Use for your top-level recipes (product formulations) for which you want to generate 

nutrition labels. 

 
(yellow 

pear) 

Sub-recipe Use for those ingredients that have ingredients of their own—your internal recipes that 

will be used as ingredients in your product formulations. You will draw the ingredients 

for these sub-recipes from your own raw materials, or from other sub-recipes. 

 
(yellow 

pear) 

Raw material Use for basic ingredients. These ingredients are usually a single component and 

sourced from external suppliers. For raw materials, you generally supply their nutrient 

analyses from the supplier’s product specification, commissioned analyses, or by 

basing them on a similar reference food supplied with FoodWorks. For compound 

ingredients you would also enter the ingredient statement. 

 

   

NOTE: Each type of document is based on an underlying document template. You 
can add new templates and modify the default document templates for a database. 
When you modify a template, documents in the database that are based on that 
template may also be changed. For how to modify templates, see the FoodWorks 
on-line help. 

Sources of food composition data 

FoodWorks comes with several sets of reference food composition data, referred to as 
data sources.  

FoodWorks data sources are not stored in your FoodWorks database, and are not 
modifiable by you.  
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The main FoodWorks window 

The FoodWorks application window is opened when you start FoodWorks. This 
window provides a view into your FoodWorks database. The name of your database is 
displayed at the top of the window. 

The window shows: 

▪ the contents of your database—its folders and documents 

▪ the open document, for example, a raw material or a recipe 

▪ the analyses of the open document 

The major elements of the FoodWorks window are described below.  

Figure 1—The FoodWorks Window  

 

 

The open 

document displays 

the selected raw 

material, sub-

recipe or recipe as 

a series of tabbed 

pages. 

Click the tabs to 

view or edit 

information in the 

document. 

The Navigation 

Pane displays 

all the folders 

and documents 

in your 

database. 

The Analysis 

Pane shows 

analyses for 

the open 

document. 

 

Name of the 

open database.  

The FoodWorks 

toolbar.  

Name—and 

folder—of the 

open document  

Your 

FoodWorks 

folders. Click a 

folder to open 

it and display 

its contents 

below. 

This box 

appears to 

show the 

recipes in 

which the open 

document is 

used as an 

ingredient. 

The contents 

of the selected 

folder—in this 

case, All 

Folders.  

Click a 

document here 

to open it in 

the middle of 

the window. 
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Navigation Pane 

The Navigation Pane is displayed down the left side of the FoodWorks window. It shows 
you the folders and documents within your database.  

To open a folder or document: Click the name of a folder or document in the Navigation 
Pane. 

To show or hide the Navigation Pane: On the View menu, click Navigation Pane, or 
press F6.  

To resize the Navigation Pane: Point to the right-hand border until the pointer turns 
into the resize pointer, then drag to the new position.  

 

Open Document  

The middle of the FoodWorks window displays the currently open document, for 
example, a recipe. This document is selected in the Navigation Pane, and its name is also 
shown at the top of the document. Only one document is open at any time. Each 
document is displayed as a set of tabbed pages. You click a tab to view a page. 

Analysis Pane 

The Analysis Pane is displayed down the right side of the FoodWorks window. It shows 
analyses of the currently open document. 

To show or hide the Analysis Pane: On the View menu, click Analysis Pane; or press F8; 
or on the FoodWorks toolbar, click the View Analyses button: 

 

To resize the Analysis Pane: Point to the left border until the pointer turns into the 
resize pointer, then drag to the new position. 

 
Resize pointer 

Resize pointer 

View analyses button 
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Selecting an analysis  

How you select an analysis to display depends on the width of the Analysis Pane. 

If the Analysis Pane is wide, to select the type of analysis you want to view: Click an 
analysis in the list on the left.  

 

 

Wide Analysis Pane… 

… showing the list of analyses down the left. 

Click an analysis to select it. 
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If the Analysis Pane is narrow, to select the type of analysis you want to view: Click the 
down arrow, then click an analysis in the drop-down list.  

  

 

NOTE: The analysis options most useful for your nutrition labelling task are Label, 
Country of Origin, Warning Statements, Advisory Statements and Allergens. 

Narrow Analysis Pane  

Click the down arrow to show the list of 

analyses as a drop-down.  

Then click an analysis to select it. 
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Toolbar and status bar  

The FoodWorks toolbar is shown across the top of the FoodWorks window and 
provides short-cuts for commonly used commands.  

 

 

 

 

  

To see the name of a button in the toolbar, hover your cursor over the button. 

The status bar is shown along the bottom of the FoodWorks window. 

To show or hide the toolbar or status bar: On the View menu, click Status Bar or 
Toolbar. 

The Label W indow 

The Label window displays the automatically generated nutrition label for the recipe 
that you have open.  

To display the Label window: Click the Label button on the FoodWorks toolbar. 

 

See Figure 2 - The Label Window below. 

Label button on toolbar 

 
 
 
 
 
 
 

Previous and 

next documents 

Open a document 

or database 

Print the selected 

sections  of the 

document 

Create a new 

document or 

database 

Save the open 

document 

View the 

analyses 

View the 

ingredients tree 

for this recipe 

Open the Query 

view of your 

database 

Open the Label 

window 
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Figure 2 - The Label Window 

 

 

You can refine the label design by editing the label properties in the left side of the 
window.  

The Label Options button at the bottom of the window opens a dialog for setting 
properties that affect all the labels in your database. 

How to use the Label window is explained in 6. Designing your labels on page 52. 

Closing FoodWorks 

To close FoodWorks: On the FoodWorks File menu, click Close; or click the X in the top 
right corner of the FoodWorks window. 

 

 

On these tabs, set 

properties for this 

label.  

The Label window 

toolbar.  

The draft label for the 

open recipe. 

The Label Options 

button opens a dialog 

that has settings that 

affect all the labels in 

this database. 

If necessary, messages 

appear here that alert 

you to missing or 

inconsistent data. 

There are no 

messages for this 

label. 
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Orientation exercise 

Try this quick orientation exercise to become more familiar with the elements of the 
FoodWorks window: 

1. Start FoodWorks. 

2. Open on a recently opened database. 

When you first open FoodWorks, a blank document is opened. 

Try hiding and then showing the Navigation Pane 

1. On the View menu, click Navigation Pane. Repeat to show/hide it again. Try using 
the shortcut key (F6).  

2. Explore the options in the open document. Click each of the tabs—for example, for a 
recipe, click the Ingredients tab, the Overrides tab, and so on.  

Explore the options with the Analysis Pane 

1. Try hiding and then showing the Analysis Pane. On the View menu, click Analysis 
Pane. Repeat to show/hide it again. Try using the shortcut key (F8) or the button on 
the toolbar.  

 

2. Try resizing the Analysis Pane to show the wide view – in the list of analyses on the 
left, click an analysis to display it.  

3. Then resize the Analysis pane to show the narrow view. Click the down arrow, then 
from the drop-down list, click an analysis to display it. 

Explore the Help menu 

1. In FoodWorks, on the Help menu, click Help Topics. 

2. If necessary, to show the help menu, click the Menu button.   

3. To browse the help using the table of contents, click the Contents tab. Then click a 
book, and then a topic, to open it. 

4. To look up the index, click the Index tab, and type a search term e.g. yield. Then click 
a topic in the search results. 

5. To search the help text as a whole, in the Search box, type a search term, e.g. 
allergen, and press Enter. Then click a topic in the search results. 

Close FoodWorks  

▪ On the FoodWorks File menu, click Close—or click the black X at the top right of the 
FoodWorks window. 
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3. Nutrition labelling—Overview 

This chapter provides an outline of the steps in your nutrition labelling task with 
FoodWorks. Each step refers you to the relevant section of this guide for the procedure. 

Step 1—Set up your FoodWorks database 

If you have not yet created your first FoodWorks database, use the procedure Starting 
FoodWorks and creating your first database on page 8. 

If you want to create a new database now, see below. 

Create a new database 

To create a new database: 

2. On the FoodWorks toolbar, click New, then click FoodWorks Database File.  

 

3. Under Australia, click Nutrition Labelling And New Product Development, or 
the appropriate option for your country or region, then click OK. 

4. Select the folder in which you want to store the new database. 

NOTE: It is important to choose a location where you know that your database file 
will be regularly backed up. See Backing up your database on page 12. 

5. In the File Name box, type the name for the new database, then click Save. 

The database settings  

By default, your new database is created with all the most commonly required settings 
for nutrition labelling. This guide assumes that you are using these default settings. The 
database settings include: 

▪ The ingredients available to you when selecting ingredients for a recipe or sub-
recipe.  

By default, you choose from your own raw materials and sub-recipes. 
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▪ The nutrients, allergens and components that you are working with. 

By default FoodWorks enables a limited set of nutrients, including all the mandatory 
nutrients as well as all the allergens prescribed under the Code.  

▪ The document templates available. 

By default, for nutrition labelling the document types are recipe, sub-recipe and 
raw material. 

NOTE: Changing the default database settings 

You can change the database settings at any time. 

         To change your database settings: On the File menu, click Database 
Properties, make your changes, and click OK. For more information see the 
FoodWorks on-line help.  

         To change the default document templates, see the FoodWorks on-line help. 

Step 2—Enter your raw materials and sub-recipes 

You are now ready to enter your ingredients into FoodWorks: 

1. Add your raw materials to your FoodWorks database—see 4. Adding raw materials 
on page 23. 

2. Add your sub-recipes to your FoodWorks database—see 5. Adding sub-recipes and 
recipes on page 35.  

Step 3—Add your recipes 

With your ingredients in the database, you can now enter the top-level recipes for 
which you wish to generate labels: 

1. Add your recipes to your FoodWorks database—see 5. Adding sub-recipes and 
recipes on page 35. 

2. As you enter each recipe, check its label information and resolve any issues—see 
Exploring the analyses on page 47. 

Step 4—Design and publish your labels  

FoodWorks automatically generates a draft label for a recipe with the click of a button. 
You can then refine the label design to suit your particular requirements: 

1. View the draft label for a recipe—see Viewing the draft label on page 52. 

2. Refine the label design—see Setting the label properties on page 53 and Setting label 
options for all labels on page 56. 

3. Publish your labels—see 7. Publishing your labels on page 62. 
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4. Adding raw materials 

This chapter explains how to add your basic ingredients—raw materials—to your 
FoodWorks database. 

Before you start 

A raw material in FoodWorks is usually a single-component ingredient (though it may 
be a compound ingredient) sourced from an external supplier. Raw materials in 
FoodWorks are different to recipes and sub-recipes in that you need to supply their 
nutrition information. (In recipes and sub-recipes the nutrition information is 
calculated using the list of ingredients.) 

Icon in 

FoodWorks 

Document Usage 

 
(yellow 

pear) 

Raw material Use for basic ingredients. These ingredients are usually a single component and 

sourced from external suppliers. For raw materials, you generally supply their nutrient 

analyses from the supplier’s product specification, commissioned analyses, or by 

basing on a similar reference food supplied with FoodWorks. For compound ingredients 

you would also enter the ingredient statement. 

 

When adding a raw material, you will need the following information: 

▪ The nutrition information for the raw material. 

You can source the nutrition information from the supplier’s product specification 
sheet or from commissioned analyses. 

Or you can use FoodWorks to derive the nutrition information from a similar 
reference food. 

You can also use a mixed approach—basing the nutrition information on a reference 
food in FoodWorks, and then overriding those nutrient values for which you have 
more specific data available. 

▪ The presence of any allergens in the raw material. 

▪ The statement of ingredients or ingredient listing for the raw material, if this raw 
material is a compound ingredient. This should be available on the product 
specification sheet. 

▪ The declaration name to use when the raw material appears in the ingredient 
statement for a recipe. 

▪ For Country of Origin Labelling, the percent Australian for this raw material. (See 
the Note below.) 
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NOTE: Setting up your raw materials for Country of Origin Labelling   

See the companion guide Getting Started with Country of Origin Labelling in 
FoodWorks 10 for how to set the percent Australian for your raw materials, 
including how to use the CoOL Editor to set up multiple raw materials. 

Adding a raw material  

To add a raw material to your FoodWorks database follow these steps. 

A. Create the new raw material in FoodWorks  

To create a new raw material: 

1. On the FoodWorks toolbar, click New, then click Raw Material.  

 

2. On the General tab, in the Name box, type the name for the raw material. 

 

3. Optionally, enter your ID for the raw material. 

4. Click the Folder drop-down button. 

 

https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-Guide
https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-Guide
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5. Select the folder in which you want to store the raw material. If you want to create a 
new folder, click the ellipsis (…) button. 

 

B. Choose how the ingredient will  be declared  

To select how you want this raw material to be declared when it is an ingredient in a 
nutrition label: 

1. Click the Label Declaration drop-down button.  

 

2. Select how you want the raw material to be declared on nutrition labels—each type 
of label declaration is explained below. 

3. Then fill in the relevant fields for that declaration type.  

Declare the raw material as a compound ingredient  

When you declare a raw material as a compound ingredient, then when it appears 
within the ingredient list on a nutrition label, it is declared as its declaration name 
followed by its own ingredients listed in parentheses(). 

In contrast, you can declare a raw material as a simple ingredient, with no ingredient 
list. See Declare a raw material as a simple ingredient on page 28.  

To declare a raw material as a compound ingredient: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button. 
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2. Click Compound Ingredient. 

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a common or generic name for the raw material—see the Food 
Standards Code 1.2.4, Clause 4.  

4.  (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredients group 
on page 30 for more information.  

5. In the Statement (>5%) box, enter the ingredient statement to be used if the 
ingredient comprises more than 5% of the total recipe .  

6. From the Statement (<5%) drop-down button:  

▪ Select Same As Above if the same ingredient statement applies in both cases.  

▪ Select No Declaration if no ingredient list will be declared on the label if the 
ingredient is less than 5% of the total recipe.  

▪ Select Alternative Declaration for an ingredient statement to be used if the 
ingredient comprises less than 5% of the total recipe. Then type the statement.  
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NOTE: Declaring a compound ingredient—less than 5%, greater than 5%  

How you declare the ingredients for a compound ingredient may depend on whether it 

forms more or less than 5% of the final product. See Standard 1.2.4 of the Food 

Standards Code, clause 6.  

Declare a raw material as an additive  

To declare a raw material as an additive when it appears on nutrition labels: 

1. In the open raw material, click the General tab, then click the Label Declaration 
drop-down button.  

2. Click Additive.  

 

3. In the Class Name box, type the class name you want to appear in nutrition labels.  

4. In the Additive Code box, type the code for this additive. Food Additive Code 
numbers are listed in Schedule 2 of Standard 1.2.4.  

Declare a raw material as a pr ocessing aid 

To declare a raw material as a processing aid—that is, it will not be shown on nutrition 
labels: 

1. In the open raw material, click the General tab, then click the Label Declaration 
drop-down button.  

2. Click Processing Aid. 
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Declare a raw material as an inedible component 

To declare a raw material as an inedible component —that is, it will not be shown on 
nutrition labels:  

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Inedible Component. 

 

Declare a raw material  as a simple ingredient  

To declare a raw material as a simple ingredient on nutrition labels—that is, as an  
ingredient without an ingredient list of its own: 

1. In the open document, click the General tab,  then click the Label Declaration 
drop-down button.  

2. Click Simple Ingredient.  

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a common name for the raw material—see the Food Standards 
Code 1.2.4, Clause 4.  

4.  (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredient groups 
on page 30 for more information. 
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Declare a raw material as a reconstituted ingredient  

To declare a raw material as a reconstituted ingredient on nutrition labels: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Reconstituted Ingredient. 

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a common or generic name for the raw material—see the Food 
Standards Code 1.2.4, Clause 4. 

4. (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredient groups 
on page 30 for more information.  

5. In the Statement (>5%) box, type the ingredient statement to be used if the 
ingredient comprises more than 5% of the total recipe.  

6. From the Statement <5% drop-down button:  

▪ Select Alternative Declaration for an ingredient statement to be used if the 
ingredient comprises less than 5% of the total recipe. Then type the statement. 

▪ Select Same As Above if the same ingredient statement applies in both cases.  

▪ Select No Declaration if no ingredient list will be declared on the label if the 
ingredient is less than 5% of the total recipe.  

7. In the Rate box, enter the ratio at which this raw material will be reconstituted. (For 
example to dilute 1 litre of the raw material with 4 litres of water, in the Rate box, 
enter 5.)  
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About ingredient groups 

Ingredient groups are categories you define—such as fruit, nuts, milk products—to 
group ingredients when they appear in the ingredient list of a nutrition label. This 
allows an ingredient to be declared in ingredient lists as part of that group e.g. if 
the raw materials cashews and almonds have been assigned to the group nuts, then 
they can appear in labels as nuts (cashews, almonds). 

If you want a raw material to be assigned to an ingredient group, such as nuts or 
milk products: In the Ingredient Group box, either type a new ingredient group 
name or select an existing one from the drop-down.  

When you create a new ingredient group by typing it into a document, this 
ingredient group now appears in the drop-down list for other documents in this 
database.  

Note that to use an ingredient group in a label for a particular recipe you need to 
set the properties for the label: Open the recipe, and on the FoodWorks toolbar, 
click Label, then select the ingredient group on the tab. See Set characterising 
ingredients and components on page 55. 

C. Base the nutrient values on an existing food 

Using this procedure, you can base the nutrient values on a reference food (from a data 
source in FoodWorks), or on another FoodWorks document in your database.  

If you want to type in values from an from an external source, skip to D. Enter nutrient 
values on page 31. 

To derive the nutrient values for this raw material from a reference food or another 
FoodWorks document: 

1. Click the Nutrients & Components tab.  
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2. To the right of the Base Analysis On drop-down button, click the ellipsis (…) 
button. 

 

The Select Food/Recipe dialog is displayed. 

 

3. Under Search these Data Sources, select the data sources from which you want to 
select the food. If you want to select from your own documents in this database, 
select the check box Also show foods/recipes in this database. (When you close 
this dialog, your choices are saved for next time.) 

4. In the Food/Recipe box, type the first few letters of each word in the name of the 
food you want to use until it is displayed. Select the food you want from the list box, 
then press Enter.  

If you wish to edit the nutrient values, use the following procedure. 

See the Tips for finding ingredients on page 46 for more information on searching for 
foods. 

D. Enter nutrient values  

Use this procedure to enter nutrient values for your raw material from an external 
source, such as the supplier’s specification or laboratory analyses.  

You can also use this procedure, if necessary, to override some of the nutrient values 
that you have derived from a reference food or FoodWorks document in the last 
procedure. 

The source of 

the selected 

food is shown 

here. 
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To enter nutrient values for a nutrient or component: 

1. On the Nutrients & Components tab, on the left, click the category of nutrient that 
you wish to work with.  

 

 

2. In the Value column, type the value for the nutrient, then press Enter. 

NOTE: Be sure to use the appropriate unit for the nutrient in FoodWorks. You can 
see the unit beside the nutrient name in the Nutrient/Component column. For 
example for sodium, the correct unit is mg, not grams. 

This tabbed page also has information about allergens, including warning and advisory 
statements. These are dealt with in the next procedure. 

Click the 

category of 

nutrient in the 

left column. 
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E. Declare the presence of allergens  

To declare the presence of allergens and set warning and advisory statements for this 
raw material: 

1. On the Nutrients & Components tab, on the left, click the category that you wish to 
work with—Warning Statements, Advisory Statements, or Allergens.  

 

2. For Warning and Advisory Statements, for each allergen listed, click in the Value 
column and select either Yes or No.  

3. For the other allergens, listed under Allergens for each allergen listed, click in the 
Value column and select Yes, No or Maybe.  Yes is for a Contains statement, Maybe 
for  a May Contain statement. 

NOTE: It is quick to type y for Yes, n for No, m for Maybe. 

 

Click here to 

show where 

any data is 

missing. 
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NOTE: Missing values for allergens 

If you do not enter a value for every warning statement, advisory statement and 
allergen, then warning messages are displayed.  

         To see the warning messages that alert you to missing data: Click the red 
message at the bottom of the open document. 

NOTE: Setting the statements and allergens you need 

         To change which warning and advisory statements and allergens are shown, 
on the File menu, click Database Properties. Click the Nutrients & Components 
tab. On the left, click the category that you wish to work with—Warning 
Statements, Advisory Statements or Allergens. Select and de-select as required, 
then click OK. 

F. Save the raw material  

To save the raw material: 

▪ On the FoodWorks toolbar, click Save. 

You have now added your first raw material to the FoodWorks database. You can see 
your new document in the Navigation Pane of FoodWorks, and it is available for you to 
use as an ingredient when you are entering a sub-recipe or recipe into FoodWorks. 

G. Repeat for the next raw material  

Repeat these steps for your next raw material. 

What next? 

After adding the raw materials, you can now add your sub-recipes and recipes, as 
explained in the next chapter. 



INTRODUCTION TO NUTRITION LABELLING WITH FOODWORKS® 35 

5. Adding sub-recipes and recipes 

This chapter explains how to add a sub-recipe or a recipe to your FoodWorks database: 

▪ Sub-recipes are ingredients that have ingredients of their own. They are your 
internal recipes that will be used as ingredients in your final product formulations.  

▪ Recipes are your top-level recipes (product formulations) for which you want to 
generate nutrition labels. 

Icon in 

FoodWorks 

Document Usage 

 
(bowl) 

Recipe Use for your top-level recipes (product formulations) for which you want to generate 

nutrition labels. 

 
(yellow 

pear) 

Sub-recipe Use for those ingredients that have ingredients of their own—your internal recipes that 

will be used as ingredients in your product formulations. You will draw the ingredients 

for these sub-recipes from your own raw materials, or from other sub-recipes. 

 

NOTE: In practice, there is little difference between a sub-recipe and recipe in 
FoodWorks. The procedure for entering them is essentially the same. For 
convenience, in the rest of this chapter the term recipe encompasses sub-recipe. 

Adding a recipe 

This procedure assumes that you have already created any raw materials that you wish 
to use in the recipe (see Adding a raw material on page 24). 

To add a recipe to your FoodWorks database: 

A. Create the new recipe 

To create a new recipe: 

1. On the FoodWorks toolbar, click New, then click Sub-Recipe (if this is an internal 
recipe to be used as an ingredient) or Recipe (if this is a top-level recipe from which 
you want to generate a label).  
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2. On the General tab, in the Name box, type the name for the recipe. 

 

3. Optionally, enter your ID for the recipe. 

4. Click the Folder drop-down button. 

 

5. Select the folder in which you want to store the recipe. If you want to create a new 
folder, click the ellipsis (…) button. 
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B. Declare this recipe for use as an ingredient in labels  

To select how you want this recipe to be declared on a label when it used as an 
ingredient in another recipe: 

1. Click the Label Declaration drop-down button.  

 

2. Select how you want the recipe to be declared when used as an ingredient— each 
type of label declaration is explained below. 

3. Then fill in the relevant fields for that declaration type.  

Declare a recipe as a sub-recipe or recipe 

Choose this option if you want the ingredients of this recipe to be merged into the final 
ingredient list of any recipe of which it is itself an ingredient. 

To declare the recipe as a sub-recipe or recipe when used as an ingredient in other 
recipes: 

1. On the Label Declaration drop-down list, choose Sub-recipe or Recipe. 

 

Declare a recipe as a compound ingredient  (based on overrides)  

If you declare this recipe as a compound ingredient, then on labels of other recipes, it 
will be shown as its declaration name followed by its own ingredient list in parentheses.  

Choose this option if you want the recipe’s ingredient list to be drawn from what you 
enter in the Statement (>5%), rather than from its actual ingredients.  (If you want the 
recipe’s own ingredients to be used, see Declare a recipe as a compound ingredient (from 
ingredients) on page 39). 
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To declare the recipe as a compound ingredient (based on overrides) when used as an 
ingredient in other recipes: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Compound Ingredient (based on overrides). 

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a generic name for this ingredient—see the Food Standards Code 
1.2.4, Clause 4. 

4. (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredient groups 
on page 30 for more information.  

5. In the Statement (>5%) box, enter the ingredient statement to be used if the 
ingredient comprises more than 5% of the total recipe. 

6. From the Statement (<5%) drop-down button:  

▪ Select Alternative Declaration for an ingredient statement to be used if the 
ingredient comprises less than 5% of the total recipe. Then type the statement.  

▪ Select Same As Above if the same ingredient statement applies in both cases. 

▪ Select No Declaration if no ingredient list will be declared on the label if the 
ingredient is less than 5% of the total recipe.  

NOTE: Declaring a compound ingredient—less than 5%, greater than 5%  

How you declare the ingredients for a compound ingredient may depend on 
whether it forms more or less than 5% of the final product. See Standard 1.2.4 of 
the Food Standards Code, clause 6.  
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Declare a recipe as a compound ingredient  (from ingredients)  

If you declare this recipe as a compound ingredient (from ingredients), then on labels it 
will be shown as its declaration name followed by its own ingredient list (drawn from 
this recipe) in parentheses.  

To declare the recipe as a compound ingredient (from ingredients) when used as an 
ingredient in other recipes: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Compound Ingredient (from ingredients).  

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a generic name for this ingredient—see the Food Standards Code 
1.2.4, Clause 4. 

4. (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredient groups 
on page 30 for more information.  

Declare a recipe as an additive  

To declare a recipe as an additive when it appears as an ingredient on nutrition labels: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  
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2. Click Additive.  

 

3. In the Class Name box, type the class name you want to appear in nutrition labels.  

4. In the Additive Code box, type the code for this additive. Food Additive Code 
numbers are listed in Schedule 2 of Standard 1.2.4.  

Declare a recipe as a processing aid  

To declare a recipe as a processing aid when it is used as an ingredient—that is, it will 
not be shown in ingredient statements on nutrition labels: 

1. In the open document, click the General tab,  then click the Label Declaration 
drop-down button.  

2. Click Processing Aid.  
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Declare a recipe as an inedible component  

To declare a recipe as an inedible component when it is used as an ingredient —that is, 
it will not be shown in ingredient statements on nutrition labels: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Inedible Component.  

 

Declare a recipe as a reconstituted ingredient  

To declare a recipe as a reconstituted ingredient when it appears as an ingredient on 
nutrition labels: 

1. In the open document, click the General tab, then click the Label Declaration drop-
down button.  

2. Click Reconstituted Ingredient.  

 

3. In the Declaration Name box, type the name that you want to appear in nutrition 
labels. This will be a generic name for the raw material—see the Food Standards 
Code 1.2.4, Clause 4. 
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4. (Optional) To assign this ingredient to an ingredient group, either type a new 
ingredient group name or select an existing group from the drop-down. An 
ingredient group is a category you define such as Nuts. See About ingredient groups 
on page 30 for more information.  

5. In the Statement (>5%) box, type the ingredient statement to be used if the 
ingredient comprises more than 5% of the total recipe.  

6. From the Statement <5% drop-down button:  

▪ Select Alternative Declaration for an ingredient statement to be used if the 
ingredient comprises less than 5% of the total recipe. Then type the statement. 

▪ Select Same As Above if the same ingredient statement applies in both cases.  

▪ Select No Declaration if no ingredient list will be declared on the label if the 
ingredient is less than 5% of the total recipe.  

7. In the Rate box, enter the ratio at which this raw material will be reconstituted. (For 
example to dilute 1 litre of the raw material with 4 litres of water, in the Rate box, 
enter 5.)  

C. Enter the ingredients for the  recipe 

To enter the ingredients for the recipe: 

1. Click the Ingredients tab.  

 

2. In the Ingredient column, type the first few letters of each word of the ingredient 
that you require. Use the arrow keys to select the ingredient from the drop-down 
list box, then press Enter. See the Tips for finding ingredients on page 46. 
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NOTE: Source of the ingredients  

When you are selecting an ingredient, you can see its source at the bottom of the 
drop-down list. 

 

TIP: Creating ingredients on the fly 

If the raw material or sub-recipe that you want is not yet in your database, you can 
create it on the fly, and enter its details later.  

         To create a new raw material or sub-recipe while entering ingredients: In the 
Ingredient column, type the name of the missing ingredient (or simply type new), 
then click New Sub-Recipe… or New Raw Material….  

In the example below, the new ingredient sodium bicarbonate has been typed: 

 

When New Raw Material is selected this dialog appears: Type the name and 
select the required folder, then click OK. 

 

 

The source of the 

selected item is shown 

here—in this case, it is 

the Raw Materials 

folder. 
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3. In the Quantity column, type the value (a number) for the measure that you want to 
use. A drop-down list displays the available measures for this item. 

4. Select the measure using the arrow keys, or type the first few letters of the measure 
name, then press Enter. 

D. Enter the serve w eight for the recipe 

To enter the serve weight (in grams): 

▪ On the Ingredients tab, in the Serve Weight(g) box (at the bottom of the 
Ingredients grid), enter the serve weight.  

 

NOTE: If Number of Serves is showing instead, click it to toggle to Serve 
Weight(g). 

E. Enter the yield for the recipe  

If the processing step for this recipe or sub-recipe will result in a change in weight due 
to the loss or gain of water, then you need to set the yield. 

To set the yield: 

▪ If you already know the final percentage weight of the recipe, on the Ingredients 
tab, in the Yield box, type the percentage. 

▪ If you know the final weight of the recipe, FoodWorks can calculate the yield for you. 
To enter the final weight, click the ellipsis (...) button, type in the final weight, then 
click OK. 

 

F. Enter the serves per pack for the recipe  

To set the number of serves per pack: 

▪ On the Ingredients tab, in the Serves per pack box, enter the number of serves per 
pack.  

 

Click the ellipsis button to enter the final weight. 
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G. If  the recipe is a beverage 

If the recipe is a beverage or a liquid: 

1. Click the Measures tab. 

 

2. Set the density by entering a volume (in mL) and corresponding weight (in g). 

3. Select the Liquid check box. 

H. Override the generated data [optional]  

By default, FoodWorks automatically calculates for the recipe, the: 

▪ nutrition analysis for the recipe 

▪ ingredient statement 

▪ allergen declarations 

In some cases, you might wish to override some or all of these automatically calculated 
values with your own data.  

To override the automatically calculated values for your recipe:  

▪ On the Overrides tab, enter your override information. See pages 30 to 32 in Adding 
a Raw Material for more information on these procedures. 

I .  Save the recipe 

To save the recipe: 

1. On the FoodWorks toolbar, click Save. 
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You have now added your first recipe to the FoodWorks database. You can see your new 
document in the Navigation Pane of FoodWorks, and it is available for you to use as an 
ingredient when you are entering another sub-recipe or recipe into FoodWorks. 

What next? 

You should now verify the analyses for your recipe. See Exploring the analyses on page 
47. 

T ips for finding ingredients 

When you are entering ingredients for a recipe on the Ingredients tab, try these tips for 
finding them faster: 

▪ Type two to four letters only per key word of the ingredient name. This is faster and 
helps avoid spelling mistakes—for example, avo finds avocado. Typing avocado 
does not refine this search any further. 

▪ Typing the first part of two or more key words helps refine your search—for 
example, black tea, type bl tea rather than tea. 

▪ The order for typing key words does not alter the number of foods found—for 
example, tea black is identical to black tea. 

▪ Case is unimportant. FoodWorks accepts upper-case and lower-case entries. 

▪ Type the singular for foods—for example, type pea, not peas, bean not beans. 

▪ If you do not find the food, try alternative spellings or other word combinations. 

▪ For some foods, there are many different varieties. Hence, when the varieties are 
displayed that may not all fit on to the screen. Use the arrow key to scroll down and 
see more varieties. 

▪ To enter a fraction, use decimals—for example, for ½ type 0.5. 
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Exploring the analyses 

While you are creating your recipe, you can view its analyses in the Analysis Pane as you 
make changes. When your recipe is complete, you should satisfy yourself that its 
nutrition information, ingredient statement and allergen information are correct before 
moving on to designing the label.  

Here are some suggestions for exploring your analyses. 

A. Show the Label analysis in t he Analysis Pane 

NOTE: It is more convenient to explore and verify the nutrition information panel 
and ingredient statement in the Analysis Pane, as explained in this procedure, 
rather than through the Label window. The Label window, described in the next 
chapter, is for designing the label once your information is correct. 

To show the Label analysis: 

1. Make sure that the Analysis Pane is showing. If it is not, on the View menu, click 
Analysis Pane, or press F8. 

If the Analysis Pane is wide, the analyses are listed down the left of the pane.  

 

When the Analysis Pane is 

wide, the list of analyses is 

shown on the left. Click the 

analysis you require.  
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If the Analysis Pane is narrow, the analyses are shown as a drop-down list. Click the 
down arrow to display the list.  

 

By default, the Label analysis contains the mandatory nutrients. It also shows you 
the list of ingredients for the recipe. 

 

 

NOTE: Question marks (?) in the Label analysis  

Question marks (?) in the Analysis Pane alert you that there is missing or invalid 
data in the recipe and that FoodWorks was unable to complete its calculations. For 
help with finding out why the question marks are appearing, see B. Explore the 
ingredient contributions to the results below. 

NOTE: Asterisks (*) in ingredient statements 

An asterisk (*) in an ingredient statement alerts you that the corresponding 
ingredient is a compound ingredient, however, its ingredient statement is not 
known. 

The Nutrition Information 

Panel analyses. 

The list of ingredients and 

their percentages. 

When the Analysis Pane is narrow, click 

the down arrow to show the list of 

analyses is shown as a drop-down. Then 

click the analysis you require. 
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B. Explore the ingredient contributions to the results  

This procedure is useful in exploring how the results were calculated, or why question 
marks are appearing in your nutrient analyses: 

1. In the Analysis Pane, select the type of analysis required.  

2. Click the Ingredients tab in your recipe.  

3. In the Analysis Pane, click on the nutrient that you wish to explore further. The 
nutrient column will then be displayed as the last column of the Ingredients grid, as 
shown below. 

 

 

 

 

 

 

 

4. Where an ingredient has a question mark for this nutrient, in the Ingredients grid, 
right-click on it and then click Open.  

5. In the ingredient you have just opened, click the Nutrients & 
Components/Overrides tab and check for missing data. Enter any required data. 

6. If all the ingredients have question marks for this nutrient, then it may mean there 
is a more global problem with the recipe. For example, check the following:  

▪ Has a valid value been entered for the yield?  

▪ Has the serve weight been entered?  

C. Explore the nested ingredients in a recipe  

A recipe can include other recipes and sub-recipes with their own ingredients.  

To see all the nested ingredients of a recipe in a tree-like view: 

1. In the Navigation Pane, select the recipe.  

Here, the user has 

clicked on 

Saturated Fat in 

the Analysis Pane. 

The Sat.Fat 

column is then 

displayed in the 

Ingredients grid. 
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2. On the toolbar, click the View food/ingredient tree button. 

 

The Food/Ingredient Tree dialog is displayed. 

Example 

 

3. To open an ingredient from this window, double-click its name. 

4. To view the values for a specific nutrient, for example, sugars: Click that nutrient in 
the Analysis Pane. A column for that nutrient then appears in the Food/Ingredient 
Tree dialog. 

Example 

 
 

Click a nutrient in the Analysis 

Pane to show it here. 

Click on a raw material to 

see what it is based on. 
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D. Explore where an ingredient is used  

To see what recipes in your database contain an ingredient (a sub-recipe or raw 
material): 

1. In the Navigation Pane, navigate to the ingredient and select it. 

2. At the bottom of the Navigation Pane, a box appears showing you the recipes the 
ingredient is used in. 

 

 

3. As elsewhere in the Navigation Pane, simply click on a recipe name to open it to see 
how that ingredient is used.  

What next? 

Once you have checked the analyses for a recipe, you may wish to enter all your 
remaining recipes, as described in this chapter. Or you can move on to designing the 
nutrition label for the recipe—as explained in the next chapter. 

 

This box shows the recipes that 

the open document is used in as 

an ingredient, and in square 

brackets, how much of it is used. 
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6. Designing your labels 

Once you have entered the information for a recipe (see 5. Adding sub-recipes and 
recipes on page 35), you can view the draft label that is automatically generated by 
FoodWorks. You can then refine the label in many ways to suit your particular 
requirements. 

This chapter first explains the design options available for designing each individual 
label. You can also set some options for all the labels in the database, for example, the 
font and capitalisation used, and whether this item is shown. These options are 
explained later in the chapter. 

NOTE: It is more convenient to explore and verify the nutrition information panel 
and ingredient statement in the Analysis Pane in the Label analysis as explained in 
Exploring the analyses on page 47, rather than through the Label window. The 
Label window, which is described in this chapter, is a tool for designing the label 
once the information is correct. 

V iewing the draft label 

This procedure assumes that you have already entered the recipe for which you want to 
generate a label. 

To generate the draft nutrition label for the recipe: 

1. Open the recipe.  

2. On the FoodWorks toolbar, click the Label button.                                                              

 

The Label window appears with the automatically generated label information.  
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NOTE: Question marks in labels 

Question marks in labels alert you that there is missing or invalid data in the 
recipe and FoodWorks was unable to complete its calculations. For suggestions on 
how to investigate and correct this, see Exploring the analyses on page 47. 

If there are question marks in the Serve column, the serve weight may not have 
been set. See D. Enter the serve weight for the recipe on page 44. 

NOTE: Asterisks (*) in ingredient statements 

An asterisk (*) in an ingredient statement alerts you that the corresponding 
ingredient is a compound ingredient however its ingredient statement is not 
known. 

You can now refine the label design as explained in the following section. 

Setting the label properties  

The draft label may suit your needs, but it is likely that you will have your own 
particular requirements. To refine the label to suit your requirements, click the Label 
Properties button at the bottom of the Label window.  

Through this dialog you can make many refinements to your labels to suit your 
requirements.  

To open the Label Properties dialog and set properties: 

1. Open the recipe. 

2. Open the Label window by clicking the Label button on the FoodWorks toolbar. 

         

3. Then, click on each tab as required.  

4. Set the properties as required.  

5. The changes are displayed in the label on the right as you go. 

6. When finished, on the FoodWorks toolbar, click Save.  

The following sections discuss the options available on each tab of the Label Properties 
dialog. 
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Set the general properties  

The table below explains the properties available on the General tab of the Label 
window. 

To set the general properties for the label for this document: 

1. In the Label window, click the General tab.  

 

2. Set the properties as desired. See the table below.  

3. On the FoodWorks toolbar, click Save. 

Table 1 – Properties on the General tab of the Label Properties dialog  

Set these properties… Purpose of property 

Alternative Label Name By default, FoodWorks will display the name of the recipe in the label title. In some cases this name 

is different to the name you want to appear on the product label. This option lets you set an 

alternate name to use for the label. 

Label Description Text. 

Serving Size Description This option lets you add a description for the serving size e.g. 60 g (2 slices) 

Show % Daily Intake column The % Daily Intake column is optional. This option lets you display this column. 

Show per 100 mL, not per 100g This option lets you display the NIP with the per 100ml column, rather than per 100g. Be sure to 

have entered the specific gravity information for the recipe on the Measures tab e.g. 1mL = 0.92g 

Preparation Instructions Add preparation instructions for the product. Note that when you save this recipe, these instructions 

become available in a drop-down menu for use in other recipes. 

Storage Instructions Add storage instructions for the product. Note that when you save this recipe, these instructions 

become available in a drop-down menu for use in other recipes. 

Message Text. 
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Add nutrients to the nutrition i nformation panel  

By default, FoodWorks displays the mandatory nutrients in the nutrition information 
panel. To display other nutrients, for example, when making a nutrition claim, you need 
to enable them in Database Properties then set them on the NIP tab of the Label 
window. 

To set the nutrients for the label for this document: 

1. In the Label window, click the NIP tab.  

 

2. Select the nutrients that you want to appear in the label. 

3. On the FoodWorks toolbar, click Save. 

NOTE: Only the mandatory nutrients are visible  

By default, only some of the available nutrients in FoodWorks are enabled for your 
database. 

          To work with additional nutrients: Close the Label window, then on the File 
menu, click Database Properties, then click the Nutrients & Components tab. 
Select the desired nutrients and click OK. Return to the NIP tab in the Label 
window—these nutrients are now available for selection. 

Set characterising ingredients and components  

On the Ingredients tab, you can set the ingredients or food components that are 
mentioned in the name of the food, associated with the name of a food by the consumer, 
or emphasised on the label as characterising ingredients or components. See Standard 
1.2.10 of the Food Standards Code for details. 

For characterising ingredients, FoodWorks calculates the percentage of the 
characterising ingredient (by ingoing weight) and displays this value in parentheses 
after the ingredient name in the ingredient statement. For example, if you set 
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strawberries (which is 10% of the weight of the product) as a characterising ingredient, 
it will appear in the ingredient statement as Strawberries (10%). 

For characterising components, FoodWorks displays the name of the component and its 
percentage after the ingredient statement. 

To set characterising ingredients/components for the nutrition label of a recipe: 

1. In the Label window, click the Ingredients tab.  

 

2. To select characterising ingredients, click the desired ingredients in the list box. 

3. Select characterising components if required. 

4. On the FoodWorks toolbar, click Save. 

NOTE: Characterising components 

For characterising components to be shown they must be enabled in the Database 
Properties dialog. 

         On the File menu, click Database Properties, then click the Nutrient & 
Components tab. In the Category box on the left, click Characterising 
Components. Select the characterising components as desired. Return to the 
Label window—these characterising components are now available for selection. 

Set the Country of origin properties  

See the companion guide Getting Started with Country of Origin Labelling in FoodWorks 
10 for how to set these properties. 

The ingredients in the 

recipe are listed for you to 

select from. 

https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-Guide
https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-Guide
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Set the HSR properties  

See the companion guide Getting Started with Health Star Ratings in FoodWorks 10 for 
how to set these properties. 

Set the advanced properties  

The table below explains the properties available on the Advanced tab of the Label 
window. All of these settings are optional. 

NOTE: To see these properties on your label, set them to visible. 

If these properties are not showing on your label, you need to show them: 

         At the bottom of the Label window, click the Label Options button. Select the 
section of the label, e.g. Date Marking, and tick the box to show the section, e.g. 
tick Show Date Marking. 

To set the advanced properties for the label for this document: 

1. In the Label window, click the Advanced tab.  

 

2. Set the properties as desired. See the table below.  

3. On the FoodWorks toolbar, click Save. 

https://support.xyris.com.au/hc/en-us/articles/360001045316-Getting-Started-with-Health-Star-Ratings-Guide
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Table 2 – Properties on the Advanced tab of the Label Properties dialog  

Set these properties… Purpose of property 

Date marking 

Shelf Life (Days) Number of days. 

Date Marking Choose whether to use a Use By or Best Before statement. The date is calculated from the date you 

create this label. 

Secondary Shelf Life Number of days. Not shown on label (but is exported when you use publish your labelling 

information. 

Serves 

Net Weight (g) Number of grams for the content of the product. 

Show per Serving column By default, FoodWorks will display the per Serving column as mandated by the Food Standards 

Code. In some cases you may wish to not display this column, for example, when supplying a raw 

material to another food company. 

Show Serve Size This value is set in the Serve Weight/Number of Serves box on the Ingredients tab of the recipe. 

Show Servings per Package This value is set in the Serves per pack box on the Ingredients tab of the recipe (not the Ingredients 

tab in the Label window). 
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Setting label options for all labels 

You can control aspects of the content and look of your label in the Label options 
dialog. To open it, click the Label Options button at the bottom of the Label window. 
The table below explains the options available. All of these settings apply per database, 
that is, to all the labels generated in your database. 

Set up each part of the label  

To set up each part of your label to your requirements: 

1. Click the Label Options button at the bottom of the Label window. 

2. In the Options box on the left, select the part that you want to modify.  

 

3. On the right, make your modifications. See Table 3 – Options for each part of the label 
in the Label Options dialog on page 60 below. 

4. Click Apply to see the effect of your changes on the open label as you make them.  

5. Click the next part that you want to modify, and make the make the modifications 
you require.  

6. When you have finished, click OK.  

Here, the Nutrition 

Information Panel is 

selected for setting up. 
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Table 3 – Options for each part of the label in the Label Options dialog  

Section Set these properties… Purpose of property 

Name Show <this label part> Set whether to show this on labels. 

Label Description 

Preparation 

Instructions 

Storage Instructions Case Set the case (capitalisation) for these parts. 

Message 

Net Weight 

Date Marking 

User Name & Date 

Nutrition Information 

Panel 

Show Nutrition Information Panel Set whether to show the NIP on labels. 

Case Set the case (capitalisation) for this section. 

Use FSANZ rounding rules Allows you to choose whether to use the rounding rules required to comply 

fully with the Food Standards Code. This may not always be appropriate, 

for example, if this product is a raw material that will be used by another 

food manufacturer who must calculate the nutrition information panel for 

their final product from your data. 

Show Calories with kJ To show Calories (kilocalories) as well as kilojoules in the nutrition 

information panel. 

Show gridlines between nutrients Allows you to choose whether to show horizontal lines in the nutrition 

information panel. 

Show “less than” for small values 

Use FSANZ minimum values 

 

Set whether to include the words “less than” for small values, rather than 

giving the actual value. Control whether to use the minimums permitted in 

the Food Standards Code or not. 

Round very small values to 0 Whether to round very small values to 0, rather than displaying “less 

than”. 

For vitamins ignore missing values Whether to ignore the fact that for some ingredients the value for one or 

more vitamins is not known and to still allow an overall value for the 

vitamin(s)to be given. 

Ingredients & allergens 

Show Ingredients Whether to show ingredient and allergen statements on labels. 

Ingredients Statement Case Set the case (capitalisation) for the ingredient statement. 

Allergen Statement Case Set the case (capitalisation) for the allergen statement 

Show allergen Contains statement 

where applicable 
Set to show the Contains statement on labels. 

Show ‘May contain’ allergen 

statements when applicable 

This can be used with VITAL (Voluntary Incidental Trace Allergen Labelling) 

calculations to declare ‘trace’ amounts of an allergen. 

Append allergen statements to 

ingredient statement 

A formatting option--whether to place the allergen statement directly after 

the ingredient statement or on another line.  

Exclude allergen ‘product’ statements 

if redundant 

Whether to exclude redundant allergen product information. For example, 

if wheat products and wheat are both selected as allergens, only wheat is 

shown in the allergen declaration. 

May contain allergen statement prefix Set this box to control the prefix to use for the Contaminants statement. 

Allergens button Opens the Database Properties dialog where you can enable allergens for 

your database. 

Country of Origin See Chapter 6 in the companion guide – Getting Started with Country of Origin Labelling in FoodWorks 10. 

Health Star Ratings See Chapter 5 in the companion guide – Getting Started with Health Star Ratings in FoodWorks 10 

Characterising 

components 

Show Characterising Components Set whether to show characterising components on labels. 

Case Set the case (capitalisation). 

Append to Ingredient Statement 
 

A formatting option—whether to place the characterising components 

statement directly after the ingredient statement or on another line. 

Characterising Components button Opens the Database Properties dialog where you can set the 

characterising components to use for your database. 

Other options Default font Set the font for labels. 

https://support.xyris.com.au/hc/en-us/articles/333757050075-Getting-started-with-CoOL-Guide
https://support.xyris.com.au/hc/en-us/articles/360001045316-Getting-Started-with-Health-Star-Ratings-Guide
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Set the font for all  labels  

To set the font that you want all your labels to use: 

1. In the Label Options dialog on the left, click Other Options. 

2. Click the ellipsis (…) button next to the Font box.  

 

3. Set the font. 

4. Click OK.  
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7. Publishing your labels 

Once you have created your recipes and set up your labels there are several options for 
printing or publishing them. You can: 

▪ Print your labels directly from FoodWorks to any label printer supplied with 
Windows printer drivers 

▪ Publish your labels using label-printing software 

▪ Open your label in Microsoft Word 

▪ Publish your labels using the FoodWorks to Microsoft Word Publisher 

All these options are explained below. 

Printing labels directly to your label printer 

Print a test label  

This section only applies if your label printer is supplied with Windows printer drivers. 

To print a test label on your label printer: 

1. Make sure that your label printer is correctly configured and that the correct 
Windows printer drivers are installed. To test this, try printing a test page from 
another application such as Microsoft Word.  

2. Start FoodWorks and open a recipe.  

3. On the FoodWorks toolbar, click Label.  

4. Make sure the Set to Screen View button is not depressed. Use this button to toggle 
between the page view (which shows how your label looks when printed) and the 
more compact screen view. 

 

5. Make sure the correct printer is selected. On the Label window toolbar, click the 
Print button, then click the Printer button and select your label printer, then click 
OK.  

 

6. On the Label window toolbar, click the Page Setup button and adjust the settings as 
necessary (such as margins and paper size). Click OK.  

 

Set to Screen View 

button on the Label 

window toolbar. 

Here it is set to 

page view. 

Print button on the Label window toolbar. 

Page Setup button on the Label window toolbar. 
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7. Review your adjustments in the Label window. 

8. Click the Print button to print a test label.  

9. Click OK.  

Print the label  

To print the label for a recipe: 

1. Open the recipe for which you want to print the label.  

2. On the FoodWorks toolbar, click Label.  

3. On the toolbar in the Label window, click the Print button.  

 

4. Enter the number of copies to print.  

5. Click OK.  

Publishing labels via label-printing software 

You can publish the labelling information from your FoodWorks database to Microsoft 
Access or to a tab-delimited text file ready for use by your label-printing software.  

To publish the labelling information from your FoodWorks database to Microsoft Access 
or to a tab-delimited text file: 

1. Open the FoodWorks database.  

2. On the Tools menu, click Publish Labelling Information...  

 

3. Follow the instructions displayed.  

Print button on the Label window toolbar. 
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Opening your label in Microsoft Word 

This command simply opens a new Microsoft Word document with the label inserted as 
it was formatted in FoodWorks. 

To open the label in Microsoft Word: 

1. On the FoodWorks toolbar, click Label. 

2. On the toolbar for the Label window, click the Publish to  Microsoft Word button.  

 

Microsoft Word is started. 

3. Click the template in Word that you want to use, then click OK.  

Your label is shown in the new Word document, and you can edit as you like. 

Publishing labels to Microsoft Word  

For complete control over the format of your label, use the Publish with Microsoft 
Word command from the FoodWorks Tools menu.1 Using this command, you can 
format the label in the Word document rather than inheriting the formatting from 
FoodWorks.  

To publish a label from FoodWorks using Microsoft Word: 

1. In FoodWorks, open the recipe for which you want to publish the label.  

2. On the Tools menu, click Publish with Microsoft Word. FoodWorks now opens 
Microsoft Word. 

 

 
1 To publish a FoodWorks document using Word, you require Microsoft Word 2010 or later. 

The Publish to Microsoft Word button on the Label window toolbar. 
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3. Click the template in Word that you want to use, then click OK. The FoodWorks 
Word Publisher tool window appears. 

 

4. In the Word document, position the insertion point where you want the data to 
appear.  

5. On the FoodWorks tool window, click the button for the type of data you want to 
insert.  

6. Continue to insert data in this way until you have all the data you require in the 
Word document.  

7. In Word, format the document as required.  

Tips for using the FoodWorks to Microsoft Word Publisher  

Using templates  

Whenever you create a new document in Word, you have the option to save it as a Word 
template. This gives you a head-start the next time you publish to Word.  

To save your Word document as a template (instructions for Windows 8 or later):  

1. On the Word File menu, click Save As.  

2. In the Type box, select Document Template (*.DOTX).  

3. In the File name box type the name that you want to use for this template.  

4. Save in the location: 

C:\Users\<user name>\App Data\Roaming\Microsoft\Templates 

NOTE: <user name> means insert your computer user name. 
 

5. Click Save.  

You can then select this template when next you publish from FoodWorks to Word. 



 

INTRODUCTION TO NUTRITION LABELLING WITH FOODWORKS® 66 

Making changes 

If you change the FoodWorks document using FoodWorks while you still have the 
corresponding Word document open, to update your Word document, click the Update 
button in the FoodWorks tool window.  

If you change the FoodWorks document after closing the corresponding Word 
document, you will need to re-publish. 

Improving performance 

You can improve performance significantly by turning off the Word option that 
automatically checks grammar and spelling as you type. 

  

 


